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Abstract

JAGUAR (JAva GUi for Applied Research) is a Java software tool providing an advanced
text editor and graphical user interface (GUI) to manipulate DAKOTA (Design Analysis
Kit for Optimization and Terascale Applications) input specifications. This document
focuses on the features necessary to use JAGUAR.
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1: Introduction

JAGUAR (JAva GUi for Applied Research) is a Java software tool for automatically rendering a
graphical user interface (GUI) from a structured input specification. The dynamically-generated
interface enables users to create, edit, and externally execute analysis application input files and
then view the results. JAGUAR is built on top of the Eclipse Framework as an Eclipse Rich Client
(http://wiki.eclipse.org/Rich Client Platform/FAQ) product, providing it the look, feel, and
features of Eclipse Applications.

JAGUAR serves as a GUI for DAKOTA (Design Analysis Kit for Optimization and Terascale
Applications). It parses a DAKOTA NIDR (New Input Deck Reader) input specification and
presents the user with linked graphical and plain text representations of problem set-up and
option specification for DAKOTA studies. After the data have been input by the user, JAGUAR
generates one or more input files for DAKOTA; it can also execute DAKOTA, capturing and
(eventually) interpreting the results.

JAGUAR 3.0 is available in 32- and 64-bit platforms for Windows, Mac (Intel processors), and
Linux. JAGUAR's core source and binary distributions are under the Eclipse Public License 1.0.

Feature changelog

Jaguar 3.0

e Added support for DAKOTA 5.3

e DAKOTA study wizard using aprepro variable parameterization. Job submission
integration on select JAGUAR distributions.

e Visualize tabular graphics file through graphical charts and exporting to Excel

e Qutline views allows easy reordering of sections and grammar view for quick lookup

e Expanded online and local support for DAKOTA documentation location

Jaguar 2.1

e Added support for DAKOTA 5.2

e Synchronized autocompleting text and hierarchical graphical editors with error checking
e Cheatsheets to demonstrate the flow of creating an input deck from scratch

e Templates for the most common DAKOTA studies

e Sensitivity analysis wizard to quickly generate a screening study

e Ability to launch DAKOTA to check input decks or perform complete studies

e Help links to the DAKOTA reference manual for most keywords

e Automatic updating to work with your installed version of DAKOTA (5.0 or newer)






2: Downloading and Installing JAGUAR

A short description of the steps for downloading and installing JAGUAR is provided here;

however the most current information can usually be found on the download pages.

Install supporting JAVA software (if needed). JAGUAR requires a Java Runtime
Environment (JRE) version 6.0 or above.

If a Java Runtime Environment is not already installed on your machine, you will need to
download and install a 6.0 JRE from:
http://www.oracle.com/technetwork/java/javase/downloads/jre6downloads-1902815.ht
ml

Download JAGUAR. JAGUAR is available from the DAKOTA website
http://dakota.sandia.gov/download.html. Register to be redirected to the
download page, which you may then bookmark directly.

Download the JAGUAR package appropriate for your platform: Windows/OSX/Linux,
32/64-bit.

ATTENTION: for proper operation you should match the JAGUAR and Java
architectures. For example, 32-bit JAGUAR should be used with a 32-bit JRE, similar for
64-bit JAGUAR with 64-bit JRE. We recommend also matching the operating system
architecture, but have had success with running 32-bit JAGUAR and JRE on 64-bit Linux.

Install JAGUAR.

1. Windows users: We provide an installer that will automatically install
JAGUAR. Double-click the installer to start installing and follow the
instructions.  After installation, JAGUAR can be found in the Start menu or at
the installed folder.

2. Mac users: We provide a dmg file (Mac OSX disk image) installer for quick
installation. Double-click the installer and the installer will be mounted
automatically. Drag the Jaguar folder into the Applications shortcut folder.
JAGUAR can now be found under Applications.

3. Other users & manual installation: We provide the JAGUAR package as a
zipped archive file. Windows and Mac users should be able to double-click on
the file’s icon from a file system browser to perform the extraction. Linux
users can use the unzip utility to unzip the archive from their command-line
console. The JAGUAR installation package is self-contained, so JAGUAR can be
directly run immediately after extracting the archive. (See Figure 1). Take note
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of where you installed as you may want to create a shortcut or link to the
installed JAGUAR executable.

e Important! If you have a previous version of JAGUAR installed it is recommended to
move your personal JAGUAR workspace directory to a different location or remove it
(this directory can be found in your home directory or User_folder >Jaguar_workspace)
to prevent corruption of the workspace when running JAGUAR.

MName Date modified Type Size

configuration 1

dakreorder 1

features 11/30/2010 4:39 PM

install 1

plugins
__| «eclipseproduct 2010 3:59 PM 1KB

| COPYRIGHT 2010 3:59 PM 1KB

B3 Jaguarexe 2010 3:59 PM 52 KB
& | Jaguar.ini 2 PN C U 1KB
|| LICENSE 2KB
| README KB

Figure 1: File listing for JAGUAR installation package
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3: Running JAGUAR for the First Time

When starting JAGUAR for the first time, you should see a “Welcome” screen. As shown in
Figure 2, the Welcome screen provides quick navigation to many JAGUAR features. This screen
can be closed at any time by clicking on the “X” located on the Welcome tab and returned to at
anytime via the JAGUAR help menu (File & Welcome). The welcome screen always appears in
front of, i.e., it hides the entirety of the user interface and must be dismissed to use the
principal GUI.

To note, there is a checkbox option at the bottom to toggle showing the welcome screen at
startup. There are also navigation buttons in the top right corner to navigate between
Welcome screen content pages (Figure 2). Welcome options include the following.

e E——— ——

File Edit Window Help

aTre— u =
JAGUAR T

Welcome to Jaguar 3.0 - the new graphical user interface for creating, editing, and running DAKOTA studies!
First, cify DAKOTA executable path:

| Conilgiss gl |

Then you may beqgin using JAGUAR:
| Skart Ligils

Tours

JAGUAR is built on the Eclipse Workbench. Before starting, use these guides to orient yourself first to key Eclipse features and then to
Jaguar specifics.

¢ Edlipse Workbench Tour i@

|
& Guided To quar 100 Quick tour of key user interface elements ‘
&' Guided Tour: Create a DAKOTA Parameter Study A step-by-step guide to create a simple DAKOTA input file |

Common JAGUAR/DAKOTA tasks

# Create new DAKOTA input file Build your DAKOTA study from a basic outline i
# Create input file from template Choose from the most common DAKOTA studies to create your input
# Launch Sensitivity Analysis Wizard Quickly create a parameter screening study

Getting Help
© Consult the DAKOTA Public User Community (@ and other DAKOTA Help Resources

4 Email your feedback or get help (jaguar-help@sandia.gov)
¥ Browse known Jaguar issues (@ (JIRA tracking; SNL internal only)

IAlways show Welcome at start up ¥ I |

Figure 2: JAGUAR Welcome screen

J Configure JAGUAR. JAGUAR settings need to be configured to run correctly
. Start JAGUAR. This closes the Welcome screen and proceeds to the regular JAGUAR
view.

It is advised to configure JAGUAR with the DAKOTA executable path at a minimum. You may
also optionally specify the save and template paths. Lastly, there are preference settings
affecting toolbars described in Chapter 5: Graphical Editors.
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Note: Highlighted in red in Figure 3, Mac/Linux users may notice a setting to prepend
the DAKOTA bin directory to their execution & library paths. This is typically necessary
for DAKOTA to run correctly without affecting your global environment.

- Falls) Preferences
_type filter text ' | Jaguar . v
| FCeneral E
Jaguar DAKOTA executable  /Users/echan/Downloads/Dakota 2/bin/dakota Browse...

I [ Prepend DAKOTA bin directory to execution and library path I

i Save path [Users/echan/Documents Browse...
[
| Browse...

Templates path [usersfechan

E Display pretty names by default
"] See comments by default
# See help by default

E Push up one level of child elements

(" Restore Defaults ( Apply )

!
| @
1

A

Figure 3: Preferences for file locations and user interface behavior

Tours. The Tours section offers guides for beginning users. As JAGUAR is built on the
Eclipse Workbench, new users will benefit from the Eclipse Workbench Tour, a quick
online reference for Eclipse framework features like Views, Perspectives, etc. The
following two tours are the Guided Tours, which are presented in the form of Cheat
Sheets (See Figure 4).

2 inguae - DART Worksp

 Frddok - Jagusr (ol @
Eile [dt Window elp
98 Rosenbrock_Furddak [ “ O B Cheat Sheets © BT<0O
i s DAROT INPUT FILE dakot rosenbt x in -
i - . Creating a DAKOTA
strategy s
single_wethod Parameter Study
graphics = Introduction
tabular_graphics_data S R -
thod i guided tour, we'll creste
= u. leid s DAXOTA parameter study from
multidis_parameter_study scratch, This example is based on the
partitions 0 8 rrlti- demensaonal parsmater itudy in
model Chapter 2 of the DAXOTA User's
single Marus! Wtped formrw 3. sandin.gov]
variables dakota/docum entation/)
continuous_design 2
Jower bounds =2 =32 Atypical semple DAKOTA put
oer | 3 2 specfication consists of a model,
WP oy 2 % whath msgs vansbles through an
descriptors "x1' ‘'x2 interface (user spphcation) to
interface responses, wnd a dentive method, L
analysis_drivers 'rosembrock’ which will repeatedly evabuate the
direct model
responses
mum_objective_functions 1 IB"“" "-“’r""“:h‘;fg""_"" ”“’"‘:I'
ocson of & A eeecutable in
no_gradients rind.
!-0_ hessians > Fraferonces »
&) Chck to Begin
b Create 2 DAKOTA inpant file
» Motice
» Define Problem
» Define Flow/enton
» Observe
« ¥ Execute Problem
| Source (1) Define Problem | » (2 Define Flow/Renticn | b 1) Execute Problem & (¢ Visualize Results ::’-m:’mhm: B

Figure 4: A sample JAGUAR cheatsheet.
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JAGUAR Cheat Sheets are a useful mechanism for quickly learning how to perform
important JAGUAR operations such as opening and saving files. They utilize an interactive
step-by-step approach to guide new users through JAGUAR. Cheat Sheets usually dock
on the side of the application so as to not obstruct user interactions, and can always be
accessed from the JAGUAR help menu (Help = Cheat Sheets).

e Common Tasks

e Create new input file. This link creates an empty DAKOTA input file. New input files
can also be created by selecting New -> DAKOTA input file from the File menu.
Users must enter a file name for newly-created input files when saving them for the
first time.

e Create new input file from template. This links creates a new input file from existing
DAKOTA templates. Users must also enter a file name when saving these
newly-created input files. This action can also be accessed from the File menu by
selecting New -> DAKOTA input file from template.

Sensitivity Analysis Wizard. See “Chapter 8: Sensitivity Analysis Wizard”.

e Getting Help. The remaining links are used for DAKOTA references, sending an email to
the JAGUAR developers, and viewing existing JAGUAR bugs.
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4: Text Editors

Figure 5 shows an example DAKOTA input file in the JAGUAR text editor. The text editor
interface is the first of two primary interfaces that JAGUAR contains for creating and modifying
DAKOTA input files. For text-based editing, the “Source” tab toward the bottom of the JAGUAR
window reveals the raw DAKOTA input file text (likely only comfortable for experienced DAKOTA
users). Refer to the DAKOTA User’s Manual Section 2.3 “DAKOTA Input File Format” for a better
understanding of how input files are structured.

i haguar - Daky /DAKOTA templ _Firaddak - Jaguar =5 Eon =]
File Edit Window Help

8 *Rasenbrack Fized.dak 5%

strategy
graphics
cabular_graphics_dats

interface

analysis_drivers 'rosenbrock’
direct

no_gradiencs

no_hessians

I

Source Define Problem Define Flow/Tteration Execute Problem Wisualize Results

Figure 5: JAGUAR text editor

The JAGUAR text editor supports:

¢ Advanced syntax highlighting of errors and warnings with the ability to mouse over
keywords for additional details.

¢ Auto-completion of keywords using Ctrl-Space.

¢ Text formatting

JAGUAR 2.1 introduced highlighting keyword errors and warnings (See Figure 6). Keywords
with warnings (i.e. invalid values) are decorated with yellow squiggly lines (and a yellow warning
icon on the left). Keywords that are not recognized are decorated with red squiggly lines (and
ared erroricon on the left). For additional information, mouse over either the squiggly lines
or icons.
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9 optimization_ type

Figure 6: Warnings and errors in the text editor

JAGUAR automatically color codes main keywords in purple, regular keywords in blue,
comments in yellow, string values in green and the rest (including values and unrecognized
keywords) in black. Additionally, when the cursor is over any keyword, a tooltip with relevant
information is shown (see Figure 7).

12— interface

X analysis_drivers 'text_book'’
1 direct
15~ responses
lE interface *
l: analysis_drivers: Array of strings
o

direct (Direct function interface) *
InterfCommands.htmIZInterfApplicDF

1 subelements:
1) processors_per_analysis (Number of processors per analysis)

Figure 7: Keyword tooltip example

Autocomplete is triggered by pressing Ctrl-Space to show suggestions and then double-clicking
to select the desired keyword. However, there are two modes to be aware of:

1) Autocomplete an incomplete keyword (See Figure 8): valid keyword completions are
suggested.

2) Autocomplete from scratch (Figure 9): all keywords valid at the current position will be
suggested.

© 5 scrac

r’ @ strategy

Figure 8: Autocompleting an existing keyword

5= strategy

f=~

H = hybrid (a requirec

multi <tart (a ren

Figure 9: Autocompleting from scratch
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Let’s look into the suggestions. There are times when many valid keyword suggestions will be
possible, potentially at different ‘levels’. For example in Figure 10, we see all the available
keywords available for autocompletion after the keyword optimization_type:

“method
dot_bfgs
optimization_type

maximize (a required option) - optimization_type
minimize (a required option)

los] linear_inequality_constraint_matrix

los] linear_inequality_lower_bounds

[o3] linear_inequality_upper_bounds

(A] linear_inequality_scale_types

lo5] linear_inequality_scales
[o5] linear_equality_constraint_matrix
[o5] linear_equality_targets
(A] linear_equality_scale_types
[o3] linear_equality scales
\Alid_method
[A] model_pointer
output
L1 ] max_iterations

(1] max_function_evaluations
speculative

[o5] convergence_tolerance

lo3] constraint_tolerance
scaling

|1]final_solutions

strategy
method
variables
interface
responses

Figure 10: Keywords valid at different levels

Four groups of suggestions are presented in order of decreasing locality. Let’s take a closer look:
1. First group (optimization_type in trailing gray)

The first thing to notice is the trailing keyword in italicized grey (‘optimization_type’)
which indicates the originator or parent, and is also highlighted in the text prior. The
asterisk on the left indicates one of these required options should be selected (but
currently none is selected).

2. Second group (dot_bfgs in trailing gray)

17



These are keywords that are valid and derived from optimization_type’s originator,

dot_bfgs.

Notice the type icons on the left, e.g., ‘1’, ‘0.5’, and ‘A’, indicating that

integer, real, and string values respectively are valid.

3. Third group (method in trailing gray)

These are keywords that are valid directly in a method specification.
no type icons, representing keywords that do not require an associated value.

Notice some have
The

keyword output has a green dot icon, representing it has derived (child) keywords.

Since method is a top-level section keyword, all remaining section options appear in the

fourth group.

4. Fourth group (section)

These are the top-level DAKOTA input sections (strategy, method, variables, interface,

responses) that are applicable at the current context.

Since main sections can be

inserted anywhere, these are usually available for autocompletion, though DAKOTA

syntax may restrict the number of them that can be created.

JAGUAR allows automatic formatting of the text using Edit = Format or Ctrl-Shift-F (See Figure

11).

JAGUAR will auto-indent the keywords and clean up the specification.

For example,

double quotes are replaced with single quotes, extra spaces are removed, and keywords are
sorted in the order defined by the DAKOTA grammar.

1=~ strategy

2 single method

3 graphics

4 tabular graphics_data

5~ method

6§ dot_bifgs

model

single

9~ variables

L0 continuous_design 2

oint =1.2
oLt -
'

I1 initial |
descriptors 'xl W™

lower bounds -2 0.001

14 upper bounds 2 I 2
15 scale types 1
L& scales 4 0.1

18 irect analysis drivers
19< responses

20 objective function scales 50

1 num objective_functions 1

2 objective function scale types 'value'
3 analytic_gradients

24 no hessians

Figure 11:

strategy
2 single method
graphics
4 tabular_graphics_data
5~ method
6 dot_bfgs
model

uous_design 2

13 lower_boun

14 upper_bounds 2 2

15 scale_types '?a;:k' ‘log’
16 scales 4 0.1

17< interface

18 analysis drivers 'rosenbrock'
19 irect

20< responses

2 num objective functions 1
objective_function_scales 50
objective_function_ scale_types

24 analytic_gradients

no hessians

Effect of automatic text formatting
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Top-level specification section blocks can be compressed/uncompressed as seen in Figure 12 by
clicking the -/+ buttons to the left of a section title.
“variables

continuous design 2
initial point -1.2 1
T i

(= I T

=

12 descriptors 'xl x2"

138 lower_bounds -2 0.001

i4 upper bounds 2 2

: i) scale types 'value' 'log’

16 scales 4 0.1 9% variables[]

17< interface 17< linterface

18 analysis drivers 'rosenbrock' 18 analysis drivers 'rosenbrock’
19 direct 19 direct

Figure 12: Compacting top-level sections
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5: Graphical Editors

JAGUAR'’s graphical editors are the second primary interface for creating and modifying DAKOTA
input files. A distinguishing feature of JAGUAR is that the graphical user interface for these
editors is dynamically generated from the NIDR input specification for DAKOTA. When your
locally installed version of DAKOTA is updated, you can point JAGUAR to the new version and it
will re-render to match.

Graphical-based editing is conveniently separated into “Define Problem” and “Define
Flow/Iteration” sections; see the appropriate tabs toward the bottom of the JAGUAR window
depicted in Figure 13. “Define Problem” is where the problem to iterate on is defined in terms of
models, which map variables through interfaces to responses. “Define Flow/Iteration” is where
a method or methods and possibly a strategy are specified.

Intesface” [t
» ) RESRONSES (1

lesponses’

Figure 13: “Define Problem” portion of the JAGUAR graphical editor

Each pane in the graphical view has two components. On the left is the tree hierarchy, which
offers navigation across the structured input file. The right side of the view is where content is
displayed, selections made, and data entered. As an example, see Figure 14.
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*i Jag sers\echa
Ede Edit Windew Help
Fremenai =5

Define Problem o[AE =@

Sections =k:: VARIABLES

type filter text 1 instances (Requirement: 1+)

4 MODEL (0, VYariables” X
4 VARLABLES (1)
Variables® [vanables] (1
4 INTERFACE 1
Interfsce” [int
4§ RESPONSES 1

Responses® [re

& Source |(1) Define Problem | |» (2| Define Flow/lteration | j (1 Execute Problem| | 1) Visualize Results

Figure 14: Content selected from left is displayed on the right

Top-level groups (i.e., MODEL, VARIABLES, INTERFACE, RESPONSES, STRATEGY, or METHOD),
represented by multi-colored bricks, organize active instances of each type of top-level
specification. When such a group is selected, the right pane will display an overview of the
selection. From this page, certain top-level elements will show instance restrictions for a valid
input file, allow the user to create a new instance, and to go directly to or delete an existing
instance.

Within each top-level group lie unique instances (each represented by a gray brick). An instance
contains many possible configurable settings, which are all organized according to their
hierarchy as shown in Figure 15. We call these “elements.”

= &% MODEL
=] Model1
= sow nested
@ optional_interface_pointer
» sub_method_pointer

Figure 15: A hierarchy of possible configurable settings for MODEL.
When an instance is selected, its elements are displayed in the right content pane (see Figure
16). Note that some elements have nested elements, which are not immediately displayed in

the content pane. To view these child elements, select the element in the left hierarchy tree or
select/expand the element in the right pane.
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File Edt Window Help

a N =
Define Flow/Iteration oA@> @~ |
Sections = @y Strategy’

ez The strategy speciies the top level technique which will govern the management of iterators and models in the solution of =
ype fiker text m o the problem of inferest. [ﬁ‘
o}, STRATEGY (1) = - L
Strategy* [strategy] (37 o Savlive ey (@)
* Tabulstionof gl . ) Typyission of graphics data @
% Single method strat @l
48 METHOD (L = Details
95 Method* [method] (L1
@
]
[
(@
(@
(@
Detaily #  Single method strategy” (default) - @
Details
@
i i P
o Saurce |1 Define Problem | |+ (1) Define Flew/Meration| | 1 Execute Problem | 1 Visualize Results|

Figure 16: Display of elements from a selected strategy instance.
There are five basic types of elements in JAGUAR.

1. Element without a value. In Figure 17, notice the checkbox to the left of the element;
this allows the user to enable and disable the element. Only enabled elements are
represented in the text input file, which can be viewed in the “Source” representation
(JAGUAR text editor). Required elements cannot be disabled.

[ Self-scheduling of iterator jobs
[] output_precision

o [¥] Tabulation of graphics data

i Details: > Single method strategy * -
Elerment Options

Hybrid strategy 1 |

Multi-start iteration strategy 3

Pareto set optimization strategy 3 | |
1

Single method strategy
4| L | ¢

V] Method pointer ' methodl =

Figure 17: Different element types in JAGUAR.

2. Element with a value allows users to set values of type Integer, Real, String, or a
space-delimited list of any of these.
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3. Nested elements supported in JAGUAR are indicated by a green bullet and the presence
of a hyperlink. Selecting a hyperlink is one way to view the nested element in the
right-side content pane.

4. Drop-down lists are indicated by a choice icon. When the list is selected, it behaves like
one of the former three element types. The first element of a drop-down list functions
as a header text to guide the user’s selection of an appropriate element below. Asterisks
also indicate the default list element.

e Some drop-down lists have categories which organize the many possible options
(See Figure 18). The left drop-down categories narrow down the keywords
presented in the right list.

Details: Optimization: Plug-in - v bayes_calibration ~|®
Element Op... “| | Element Options
Optimization: Global 5 E v bayes_calibration
Optimization: Local, Derivative-based 14 dot
undefined 4 richardson_extrap
Parameter Studies 4 | stanford >

Optimization: Local, Derivative-free 5 =
MNonlinear Least Squares 3

Uncertainty Quantification

1
| Optimization: Plug-in 1
DACE 4

Figure 18 Method category drop down list and corresponding method choices

5. Pointer elements allow reference to other existing elements. Hyperlinks follow pointers
to quickly display that instance in the content pane. When an unrecognized instance
name is manually entered in a pointer element, JAGUAR automatically creates that new
instance.

The JAGUAR toolbar. Figure 19 shows (from left to right) quick access buttons for running
DAKOTA input files, displaying pretty names instead of keywords, toggling help text, displaying
comments, and toggling push-up elements (the display of one level of children in the present

right pane).
. (i 0 "
0 > @)=
Figure 19: JAGUAR toolbar for running DAKOTA or toggling several options
DAKOTA check

0 A quick way to invoke DAKOTA to check the input deck for errors. This is
equivalent to running ‘Check’ via the Execute Problem tab (see Chapter 6: DAKOTA
Execution)
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Pretty name

A Each element in the grammar has a ‘name’ and a ‘pretty name’. The ‘name’ is
the actual text used in the input deck (formal DAKOTA keyword), whereas the pretty
name is a user-friendly description of the element.

algebraic_mappings = Algebraic mappings file

analysis_components = Additional identifiers for use by the analysis_drivers

Online reference

L 2]
‘Ui’ Each element usually has a description, often with a hyperlink to the
documentation. This is visible in the GUI on the right side when the online reference

button is selected:

strategy
m Py The strategy specifies the top level technique which will govern the management of iterators and models in the solution of the
problem of interest. hitp://www.cs: i v/DAKOT A/ licensing/votd/htmil-ref/Str; man: |
| graphics 9
lor grephics data =
| output_precision 'ﬂ
| iterstor_servers o
| iterator_self_scheduling ’;]
@
7| iterator_static_scheduling P
ik Details: single_method * - [ ._;‘]
= Details
¥ method pointer what X ’:

Figure 20: Documentation/Reference

Comments

3
" In this following example, we see the comments in the source view:

Figure 21: Example of whole line and trailing comments in the source view

It should be noted there are 2 types of comments the above example:
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1. Inline (on the same line as a keyword)
2. Before (standalone comments, multiple counts allowed)

Currently comments can be rendered and edited in the GUI (See Figure 22), but new
comments can only be added from the source view.

method

1) A methed specifies the name and controls of an iterative procedure, e.g., 2 sensitivity analysis, uncertainty quantification, or optimization methed.
http://www.cs.sandy - an i d 87 odCommands.html

METHOD HEADER COMMENT

=7 method inline comment

[ id_method
[T medel pointer
¥ output

= Details

i debug

I' output inline comment l

Figure 22: An in-line comment rendered in GUI

Push up

The JAGUAR GUI is simplified by pushup elements. These elements can be
displayed in the current pane instead diving deeper in the tree to see them. This helps
show the larger context in one view. Pushup elements can be collapsed by clicking on
‘Details’.  Figure 23 and Figure 24 show JAGUAR with push-up elements on (default)
and off, respectively.

interface

I | @ Aninterface specifies how function evaluations will be performed in order to map a set of parameters into a set of responses. hitp://vww

| id_interface
algebraic_mappings
7] gnalysis drivers ‘resenbrock’

= Details

1 analysis_components
| input_filter
| output_filter
s=a | Details: »  direct
failure capture

Tl deactivate

asynchronous
.

| evaluation_servers

¥ 1 @  choose evaluation sched. >
]

| analysis_servers

daa @  choose analysis sched. * ~

Figure 23: JAGUAR with push-up elements enabled (default)
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interface

E] @ Aninterface specifies how function evaluations will be performed in order to map a set of into a set of resp http:/www.cs.sandia.gov/DAKOTAflicen
[[] id_interface
[T] algebraic_mappings
o analysis drivers .'msenbmcl.g‘ Counter: 1
o [0 asynchronous
[[] evaluation_servers
w0 @  choose evaluation sched. * -
] analysis_servers
& B @ choose analysis sched. * S

Figure 24: JAGUAR with push-up elements disabled
Hiding disabled elements
I"'

To reduce the clutter by only showing the current elements, this toggle hides all
disabled elements.

Strategy®

m @ The strotegy specifies the top level technigue which will govem the management of iterators and models in the solution of the problem of interest.

Graphics flag

L Tabulation raphics data

B
e [
-
g
D
o Details: @ Sing_le method strategx" {default) |
Figure 25: JAGUAR not hiding disabled elements
Strategy*

@ 1) The strategy specifies the top level technique which will govern the management of iterators and models in the solution of the
problem of interest.

Graphics flag

& ®)

o [V] Tabulation of graphics dat

san Details: ®  Single method strategy” (default) ~

& ®)

A

Figure 26: JAGUAR hiding disabled elements
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6: DAKOTA Execution

The Execute Problem tab permits executing DAKOTA in various modes on the active input file,
as shown in Figure 27. The execute options all require a locally installed dakota or

dakota.exe executable, the path to which can be set via Window - Preferences -
Jaguar.

mlaguar-DARTWurkspaceNserslbn'adarnfDncuments[dakatafDART,GUUhsﬁng!pstudy.i-Jaguar =1 o] ‘@
File Edit Window Help
Flvectori |8 pstudy.i 53 =0

Execute Problem

i . ) Q;) Check § . .; Run complete DAKOTA study locally on this input...
|3 Below run actions will automatically save your input file

| 2 Run | Run DAKOTA locally on this input file (starting in the directory where the input lives) and display any text output / tabular graphics data.

+ Manual override

U PreRun | Perform only pre-run (variables generation) phase; select methods only
| Pre-run tabular output filename: | pre_run_output.dat

+ Manual override

4 PostRun Perform only post-run (final results) phase; select methods only

Post-run tabular input filename:  post_run_input.dat i Browse...

+ Manual override

Override run directory:

Nate: before running, you may want to set preferences for where DAKOTA is installed on your system

4 1

Source |( 1 ) Define Problem | [» Define Flow/Tteration | » Execute Problem | Wisualize Results

Figure 27: The JAGUAR “Execute Problem” tab for running DAKOTA.

Currently four modes of DAKOTA execution are supported:

¢ Check: While JAGUAR includes considerable input validation, the Check button uses
DAKOTA’s input parser to perform additional validation, ensuring that the study input is
ready to run. To validate the active input file (via dakota -check), select the Check
button and view the console output on the Visualize Results tab. You should see a
message indicating that the check completed and should see no errors:

Input check completed successfully (input parsed and objects instantiated).
If you observe errors, return to the editor to correct them.

¢ Run: Selecting the Run button will execute DAKOTA on the local machine using the active
input file. Execution will take place in the same directory as the input file, so any
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necessary driver scripts and data files must be present. To abort the DAKOTA run, use the
operating system’s task management features to kill the separate DAKOTA process.

Progress Information

0 Running Dakota... To abort, terminate the separate dakota process.

Figure 28: Running DAKOTA

After running, view the DAKOTA output in the console window:

<<<<< Function evaluation summary: 81 total (81 new, O duplicate)

<<<<< Iterator multidim_parameter_study completed.
<<<<< Single Method Strategy completed.

* Pre Run: Pre-run is a step in the overall DAKOTA run process. For select analyzer methods
only (currently parameter studies, DACE, and sampling methods) DAKOTA supports a
pre-run mode (dakota -pre_run), which will generate the set of points at which
DAKOTA would evaluate the computational model and write them to a space-separated
tabular file. The optional checkbox Pre-run tabular output filename permits overriding
the default filename. A successful pre-run will terminate with a message:

Pre-run phase complete: variables written to tabular file pre_run_output._dat.

* Post Run: After the pre-run variables file has been augmented with user-supplied
columns for function evaluation data (responses), DAKOTA can post-process it and
generate statistics, for example, to compute final statistics in a screening study. This is
the analysis counterpart complementing Pre Run. The Post Run mode permits
specification of the variables/response data file. Executing it will generate final results
output similar to Run mode:

Post-run phase initialized: variables / responses read from tabular file
post_run_input._dat.

<<<<< Function evaluation summary: O total (0 new, O duplicate)
<<<<< Best parameters =

-2.0000000000e+000 x1

-1.0000000000e+000 x2
<<<<< Best objective function =

1.0000000000e+000
<<<<< Best data captured at function evaluation 19

For additional information on the Pre Run and Post Run modes (which are central to JAGUAR's
Sensitivity Analysis Wizard), consult the DAKOTA User’s Manual. Results from any execute
option are displayed on the Visualize Results tab as shown in Section 7: Visualization.
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For all problem execution modes under Run, a Manual override option (See Figure 29) allows
modification of the command issued to execute the dakota program. In future JAGUAR
releases we hope to support the Core Run and Remote job submission execute modes,
including facilitating remote DAKOTA job submission to a compute cluster and job status

monitoring.

| 3 Run Run DAKOTA locally on this input file (starting in the directory where the input lives) and display any text output / tabular graphics data.

& " "C\dakota53\bin\dakota.exe™ -input "C:\Users\echan\testddd.i" " = [L4 Execute

Figure 29: Manual override DAKOTA command
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7: Visualization

The Visualize Results tab in Figure 30 displays the result from executing DAKOTA under various
run modes.

T8 Jaguar - CAUsers\echan

Eile Edit Window Help
B vesti (G "test ‘HMASS X =

Visualize Results ‘

|I-Ei DAKOTA Qutput: "C:\dakota53\bin\dakota.exe” -input "C:\Users\echan'\testd44.i” I

a 1.00000e+00 3
b -6.24801e-03 1.00000e+00
response_fn_1 2.42646e-01 9.56713e-01 1.00000e+00

Partial Correlation Matrix between input and output
response_fn_1
& 8.54292e.01
b 9.87767e.1

Simple Rank Correlation Matrix amang all inputs and outputs:
a bresponse_fn_1
a 1.00000e+00
b -3.70837e-03 1.00000e+00
response_fn_1 2.21782e-01 9.67885e-01 1.00000e+00

Partial Rank Correlation Matrix between input and output
response_fn_1
& 8.96493e.01
b 9.93455¢.1

<<<<< lterator nond_sampling completed
€<<<< Single Method Strategy comy
DAKOTA execution time in seconds:
Totel CPU = 0,031 [parent= 0.031. child = LU}
Total wall clock = 0.028003

ed.
;

Hteration Histery Plots
& Input/Ouput Scatter Plots

" DAKOTA: Execution successful

4 Highlight values Min: Max:

& Tabular File Qutput: Menitoring dakota tabular.dat Last modified: 2:37:15 PM (3 sec age) | | | Browse.. B Export... |

o Source |1 Define Problem | b (2) Define Flow/Iteration | b (1) Execute Problem | | (1) Visualize Results

Figure 30: Visualize DAKOTA output results and charts

Additionally, plots are graphically generated when strategy->tabular_graphics_data is turned on
to generate the default dakota_tabular.dat file. Iteration history plots in Figure 31 show the
progression of input variable values (x axis) against iteration number (y-axis) as well as the
output response (x axis) against iteration number (y-axis). The first gives a running visual
illustration of where Dakota has evaluated each input; the second provides an output check.
This can be especially helpful for optimization problems.
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E Iteration History Plots

3 200
V @ 100
> > 0
2
T T T T T -100
0 50 100 0 50 100 ] 100
a b response_fn_1

Figure 31: Iteration History Plots

Input/output scatter plots in Figure 32 show the set of all inputs and outputs plotted against
each other in 2D.

Il‘ Input/Quput Scatter Plots

100 100
- »;
= bt
& 23
£50 50 : ‘__--*
e
] i
T T T
3 EL 4
b response_fn_1
1 1
08 08
w06 0.6
a
Q04 04
02 02
0 0
—r—t——— it} " i T T T
2222426128 3 3 32 34 36 38 ¢ 20 40 60 80 100
a b response_fn_1

Figure 32: Input/Output Scatter Plots

34



The graphical charts can be saved by selecting the “Save Plot...” button in the bottom right
corner.

Below the plots is the status bar (Figure 33), showing the DAKOTA run status on the left, the raw
tabular graphic file in the middle, and option to specify an existing tabular file to plot, and to
export the tabular file to Excel.

' DAKOTA: Execution successful 8 Tabuler File Output: Monitoring dakota tabular.dat Last modified: 2:37:15 PM {1 hours, 40 min ago) Browse...| | @ Bxport...

Figure 33: DAKOTA run status, tabular graphic file and export options
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8: Sensitivity Analysis Wizard

Future JAGUAR versions will include a suite of “wizards” for creating DAKOTA input files for
common analysis tasks such as optimization, parameter estimation, and uncertainty
quantification. Presently, one such wizard exists for creating a Latin hypercube sampling-based
sensitivity analysis (SA or screening) study. It creates a DAKOTA input file based on
user-specified problem characteristics and optionally allows running DAKOTA in pre-run mode
to generate a table of variable realizations. The SA Wizard also allows running DAKOTA in
post-run mode as described above to analyze user-provided tabular response data. The SA
Wizard is accessible from the Welcome screen and the menu File & New - Sensitivity
Analysis Wizard. Upon launching, select either the variables definition (pre-run) phase or
analysis (post-run) phase as shown in Figure 34.

¥ DAKOTA Sensitivity Analysis Wizard o [[@
DAKOTA Sensitivity Analysis Wizard

The JAGUAR Sensitivity Analysis Wizard will guide you through creating a Latin hypercube
sampling study to assess the relative importance of variables on your computational model's outputs,

*You will specify the relevant variables {(parameters) and their bounds, number of samples
{model evaluations), and JAGUAR will generate a run matrix of samples to evaluate.
*You may either manually evaluate your model and provide the response data to DAKOTA in
tabular format, or edit the input to have DAKOTA, run the model,
* Once responses are available, DAKOTA can post-run to compute simple statistics and correlations on
the data, which indicate the importance of factors.

NOTE: JAG
location in

aworking installed DAKOTA for this feature, You can specify the

Start wizard from:
@ Step #1: Pre-run (variables generation before post-run)
Step #2: Post-run (already completed pre-run earlier)

d

':_.__." Back Next » nisk Cancel

Figure 34: The splash page for the JAGUAR Sensitivity Analysis Wizard.

Figure 35 shows the Specify Variables page of the SA wizard, where the problem characteristics
are entered. The number of samples, uncertain (uniformly-distributed) variables, and responses
must be specified. For each specified variable, lower and upper bounds are required; there are
also optional fields for specifying descriptors for each variable. Once complete, one may
generate the LHS samples in the form of a run matrix using the Generate samples option,
and/or save the input file for the LHS study using the Save input file option and specifying a
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location for the input file. (Saving the input file at this step will end the wizard and open the
generated input file in the JAGUAR editor.)

I3 DAKOTA Sensitivity Analysis Wizard (Pre-run) o [& =]

Specify Varniables
Specify the table contents

Uniform Uncertainty

MNumber of samples 3 [ G ]
uniform uncertain variables 3 [ ‘-‘J
Al Descriptors* los]  Distribution lower bounds* 03] Distribution upper bounds*
‘alpha’ 0.0 10
‘density’ 35.2 741
‘bias’ -4 -2
MNumber of response functions 1 F

@ Generate samples
Save input file:

Ci\Users\briadam\Documents\dak

‘:‘3) E < Back ;l INext > l Einish Cancel ]

Figure 35: Pre-run phase: variables specification

Figure 36 shows an example of the Run Matrix (final) page of the pre-run wizard containing the
generated run matrix if the “Generate samples” option is selected. Note that this option
executes the locally-installed version of DAKOTA (in pre-run mode) to generate the run matrix.
The page also provides options for saving both the input file and the generated run matrix.
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m DAKOTA Sensitivity Analysis Wizard (Pre-run) = 3]
Run Matrix
Result from DAKOTA

Output

0.90815088271466615 69.412414316083627 -2.1489913173258133
0.22167623061470165 63.221491596224006 -2.7679243394888410
0.34077156037850265 69.791624581565827 -3.9309327791466617
0.30150033770735529  73.827913546922801 -2.5351976992475778
0.97223801965023893  52.202691976253106 -2.6336655606479181
0.94517384481962852 53.112427962673173 -3.8019200436402718
0.87999812217407614  53.924905034636012 -3.0093594872024516
0.78855639295977367 37.338622113269091 -2.1307991611619679
0.82689296050798577 45.763497378464336 -3.6391578719881906
0.607126613434534  36.042063408797525 -3.606540781175068
0,50912427270871607 43.190500020256358 -3,3011807988744315
0.90055082201806091 73.023636464251538 -2.4644632720561739
0.73551382145541176  40.744801552429451 -2.6801234905629654
0.71293979480630677  39.443671491547754 -2,5651813295215025
0.65810938858492085 40.120980820169699 -3.4561183544872112
0.097300437495632219  55.64503931054086 -3.248011989324072

<
Save options

V| Save input file

File: | CaUsers\briadamiDocumentsidakota\DART_GUNtestingsawizard2.in|

V| Save run matrix to file

MOTE: add a column for each response of interest to the run matrix (.dat) before performing post-run.

File:  cosers\briadam\Documents\dakota\DART_GURtesting\runmatrix.csv
raw (space-separated values) for Tecplot, Matlab, gnuplot

@ CSV (Comma-separated values) for Excel

®

< Back Iext L Einish Jl Cancel

Figure 36: Pre-run phase: run matrix and save options

After creating a samples file (run matrix), one may add columns for response data to the file,
then return to the SA Wizard’s post-run mode. Figure 37 shows specification of the saved input
deck from pre-run and the location of the data file containing the variables and response data to
analyze. Selecting Next will run DAKOTA in post-run mode, generating any statistics or other
final results.
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Analysis Type
Specify the parameters

Parameters
Input file:

File:  CaUsers\briadam\Documents\dakota\DART_GUI\testing\pstudy.i Browse...

Post-run input file:

File:  CaUsers\briadam\Docurmentsidakota\DART_GUNtesting\post_run_input.dat Browse...

® I < Back " Nedt> | | Enish | Cancel I

Figure 37: Specifying the DAKOTA input file and data file for post-run mode.
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9: DAKOTA Study Wizard

The DAKOTA Study Wizard simplifies the preparation of files necessary for a DAKOTA study.

Open a file in plain text from the menu: File = Open As, and choosing “Plain text” when
prompted in Figure 38.

rﬁ Editor Type [

'.el' Please specify which editor type you would like to open this file as

E Jaguar Editor ; [ Plain text

Figure 38: Open As Plain Text

In the text editor, highlight the value you would like to parameterize, and right click to “Create a
parameter” in Figure 39.

begin property spedfTTCECTONTON material linear_elastic_steel
density [ ————
| hdo Ctrl+Z
begin parameters for mod Revert File
youngs modulus = 1.99 -
{ F— Sawe Ctrl+S
peissons ratio = @.33
yield stress = 2757902 5
hardening modulus = 27 Open With 5
beta = 1.@ Show In Alt+Shift+W »
end parameters for model
Cut Ctrl+X
end property specification
RITOpENEY. 5P Copy Ctrl+C
begin property specificati Paste Ctrl+V
density = 11253,
Shift Right
begin parameters for mod Shift Left

youngs modulus = 1.3Z
poissons ratic = @.
yield stress = 1378991 ©
hardening modulus = @.
beta = 1.0

Create a parameter

Preferences...

- VA A e -

Figure 39: Creating parameter from file

Specify a name for this parameterization in the dialog (Figure 40).

B Specify variable name (23]

Specify variable name

Enter a variable name to create an aprepro variable

Variable narme: density_vall
Variable value: T8TL.966958

Comment character: #

[ OK 1 [ Cancel

Figure 40: Specifying parameter name
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Notice the file in Figure 41 has been modified with the parameterized field with the original
values in comments at the top of the page. By default this conforms to APREPRO syntax.

Ll tsiemm.iis

#{density_wal = 7871.966988}
- esphere

define direction y_axis with vector .2 1.2 0.0

begin definition for function constant_velocity
type is piecewise linear
ordinate is velocity
abscissa is time
begin values
9.0 30.0
1.@ 3e.0
end values
end definition for function constant_velocity

begin property spec ki bbbmbaiempterial linear_elastic_steel
density =}{density_val}|

Figure 41: Parameter replacement

Once all parameterization has been set (a file may have more than one), run the DAKOTA Study

Wizard via New = Dakota Study. In Figure 42, the wizard makes necessary checks before
continuing.

8 DAKOTA Study Wizard

=3 8o 5

Welcome to the DAKOTA Study Wizard

This wizard will guide you through creating a DAKOTA, study based on an application analysis which you (1) previously executed via job submission and (2) have parameterized. The status
of "pre-flight checks” on the application inputs, parameters, outputs and the existence of a prior job submission are shown below to ensure you are ready to proceed,

Application Input File:  C\Users\echan\sierra.i
Pre-flight Check
" File exists

L Browise J

+” 3 parameters detected
. results.out does not exist,
Please be sure to enter instructions in postprocess.sh to generate properly forrmatted results,out file.

Next » ] Finisk Canie_l_:j

Figure 42: DAKOTA study wizard

The next step is to specify an appropriate variable type in the ‘Variable Type’ column (Figure 43).
You may disable variables not applicable in the study by unchecking them on the left.
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Identify DAKOTA Variables
@ Specify type for each variable below

Type: E_Se}ect anappropriate variable type '_]

Variable Mame  Original Value ‘ariable Type

[V D poisson_.. 0.44 Select an appropriate variable type |
|[V] @ yield_str.., 2757302917 Select an appropriate variable type |

|[¥] © density_.. 7871966988 Select an appropriate variable type |

sBaek | Net> [[ Ensh ] [conce

Figure 43: Specifying the variable types

Once all the parameters have their respective variable type defined, they can be characterized
in Figure 44.

Characterize DAKOTA Variables

@ std_deviations: Does not have all 2 values defined by lognormal_uncertain
beta_uncertain: beta uncertain alphas® is required

@ lognormal_uncertain [ a hm_.mceminl

¢ lognormal uncertain variables |

@
[

‘"; lognormal uncertain mean;’“(‘d-z.faulé

Details

a7 | 63 std_devistions* (defoult) -
[A] Descriptors [e5] Distribution lower bounds [os] Distribution upper bounds lognormal uncertain means* [os] std_deviations*
‘poisson_val' 0.44
“yield_stress_val' 2157902917

< Back I Nest > ] | Einish | Cancel

Figure 44: Characterizing variables
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An appropriate analysis template can be specified in Figure 45 to iterate over the variables, as
well as the number of concurrent runs defined in the interface.

8 DAKOTA Study Wizard

Select a DAKOTA Study Template

Select the DAKOTA analysis you wish to perform from the most common study templates, Each ternplate specifies a DAKOTA method with common defaults to iterate on the variables
previously specified. You can later customize your study details with the Jaguar DAKOTA GUIif needed.

Pick a ternplate: Preview DAKOTA input file:
filt # DAKOTA Derivative-based Local Optimization -
fype tertext # Use CONMIN FRCG algorithrm to minimize response function over
[ [ Blank Daketa fil B x 5pecif!ed"v;ga!lnles,_l[;‘msih\y subject to constraints (with
Jaguar standard templates m::;;‘m"“ kianthin,
| Annotated single_method E
Calibration Local Gradient Based NL2S0OL tabular_graphics_data
Optimization Global Genetic Algorithrn method ) ) !
Optimization Local Gradient Based CONMIN #For constrained problemns, instead use conmin_mfd
conmin_frcg

Optimization Local Pattern Search i iterations 50

Parameter Study Centered max_function_evaluations 100
Parameter Study Grid - convergence _tolerance le-4
5 = B model
Interface single
(e e iy ll_ wvariables # (Added by the DAKOTA study wizard)
. . ; . lognormal_uncertain 2
/| Save evaluation working directories means 0.44 2757902917

std_dewiations 12
lower_bounds 12
upper_bounds 23

beta_uncertain 1

®@ [ <pock [ nea> |

sk Cancel

Figure 45: DAKOTA Study Template

The last step in Figure 46 is to specify the scheduling scheme and location for the DAKOTA study.

G e = o |
Specify a DAKOTA Scheduling Scheme

Select a DAKOTA scheduling scherme and location for the DAKOTA study files. Each scheme provides a skeletan analysis driver script and related files to allow DAKOTA to automatically
execute your simulation code atvarious parameter values and post-process the simulation output.

Select Scheduling Scheme: Description:

Iﬁngle Queued DAKOTA Job with Concurrent Application Evaluations = | A single queusd DAKOTA job managing cancurrent serial or parallel application jobs within the batch allocation. -
S ~ DAKOTA runs within the queued job, and does not submit the application jobs separately to the queue. This is used
when the jobs are of small to moderate size (1005, not 10005) of CPUs and runtime (hours, not days),

Specify where to save generated DAKOTA files:

Package directory:  C:\Usershechan'DakotaStudy _sierra 'Bruwse.,.:
Input file name: dakota.in
(?;' [ Finish ] [ Cancel

Figure 46: Scheduling Scheme

When finished, the wizard creates the folders and files necessary for the DAKOTA study.
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10: Generating Input Files from Templates

DAKOTA (and consequently JAGUAR) includes many example input files that users can build on,
customizing their own studies from these templates. JAGUAR also supports User-created
templates (see Figure 47). To specify the location in which user templates are saved, go to
Window -> Preferences -» Jaguar -> Templates Path and define the template path.
Whether you want to access the standard templates library or the User-created templates to
generate a new DAKOTA input files, you can do so in two ways:

1. from the Welcome screen
2. from the main File menu (New - DAKOTA input file from template).

After selecting a template upon which the new input file will be based, specify a location in
which to save the new input file (see Figure 48). Also, at any time, you can save an input file or
template as your own custom template with File - Save -> Save As Template (see Figure
49). By default templates are saved in the default directory specified in preferences and the

default template extension is . dak.

I'_% DAKOTA Templates = \_E
DAKOTA input file templates
Choose a template for the basis of the DAKOTA input file:

Pick a template:

User-created (DAKOTA templates) -
dudd3 a
dude i
dude?
rasenbrock
rosenbrockwhatever
Rosenbrock Fixed
sample template
testagain

Jaguar standard templates
Calibration Local Datafile Exarnple

Preview template content:

Figure 47: A list of DAKOTA input file templates available in JAGUAR.

45



ﬂmmmﬂ plates. [y )

Save template

Select where to save selected template
File Ci\Users\echan\rosenbrock.i OWS! |
Current working directory: C:\Eclipse\eclipse 3.7 64

=

Organize »  New folder E- @
I Favorites Name ° Date modified Type
Bl Desktop \___] dudd3.dak 12/14/2010 2:42PM  DAKFile
8 Downloads |2\ ] dudedak 12/8/20104:03PM  DAK File
%] Recent Places ] dude2.dak 12/15/2010 408 PM  DAK File
| u rosenbrock.dak 12/16/201012:00 ...  DAKFile
(4 Libraries | rosenbrockwhatever.dak 12/17/2010 3:22 PM  DAK File
[ Documents __] sample template.dak 12/8/20104:22PM  DAKFile
o Music ] testagain.cak 12/14/20101:54 PM  DAK File
Pictures
o [ i ' ’

File pame:
Save a5 type: |Dakota Template ".dak) |

(4 Hide Folders

Figure 49: JAGUAR Save As Template window.
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11: JAGUAR Brief Usage Tutorial

To quickly familiarize yourself with JAGUAR's basics, follow the steps here which refer to the
simple dakota input file example dakota_rosenbrock 2d. in found in the
examples/tutorial directory of a DAKOTA distribution.

Start JAGUAR.

In the Welcome screen, select “Configure Jaguar” or click Window -> Preferences - Jaguar
(see Figure 50).

¢ Under JAGUAR options, provide your paths for “DAKOTA executable” (this is the full path
for the dakota or dakota.exe executable file you will use to run DAKOTA), “Save path”
(this is the full path for the directory you wish to save your input files in) and “Templates
path” (this is the full path for the directory you wish to save your own DAKOTA Templates
in).

e Select “OK”.

m Preferences {3 X
i ext] Jaguar v ¥
General P
Jaguar DAKOTA executable C:\dakota\dakota.exe Browse...
Save path C:\Users\echan\Documents Browse...
Templates path C:\Users\echan'\Documents\DAKOTA templates Browse...

V| Display pretty names by default
["] See comments by default
[¥] See help by default

| Push up one level of child elements

Figure 50: Sample JAGUAR Preferences for tutorial.

Select File - New -> DAKOTA input file from template

Do either of the following:

1. Type “tutorial” in the quick search bar to filter the templates and select “Tutorial
Rosenbrock”.

2. Navigate down and select “Tutorial Rosenbrock”.
e A preview of the template file should be visible, as shown in Figure 51.
¢ Select “Next”.
¢ Specify a filename such as “rosenbrock.i”.

e Select “Finish”.
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r
m DAKOTA Templates =

DAKOTA input file templates
Choose a template for the basis of the DAKOTA input file:

Pick a template:
tutonal

4 Jaguar standard templates
Tutorial Rosenbrock

Preview template content:
#2 DAKOTA INPUT FILE - dakota_rosenbrock_2d.in -

m

strategy,
single_method
graphics,tabular_graphics_data

method,
multidim_parameter_study
partitions = 8 8

model,
single

I = = |
k_:._’) < Ba Next > Einish Cancel |

Figure 51: Filtered list of DAKOTA input file templates
The input will be displayed in JAGUAR as shown in Figure 52. Try some of the following:
¢ Introduce errors into the input, notice error decorators, and mouse over them to see the
tooltip errors.
¢ Mouse over keywords to see additional information.

e To run the advanced parsing engine and auto-format the text, press Ctrl-Shift-F or Edit >
Format. Observe the updated rosenbrock 2d template input file depicted in Figure 53.

¢ You can always Undo (Ctrl-Z or Edit = ”Undo Typing”) and Redo (Ctrl-Y or Edit >
”Redo Typing”) to compare.
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19 Jaguar - DART Workspace/Users/briadam/Documents/dakota/DART_GUl/testing/rosenbrock.i - Jaguar

Edit Window Help

[E=5 Hoi =%

= B)(5z outline 53 =0

=

Eile
[
16
23
26
27
Source

strategy,
single method
graphics,tabular_graphics_data

method,
multidim parameter study
parcitions = 8 8

model,
single

variables,
continuous_design = 2

lower_bounds -2.0 -2.0

upper_ bounds 2.0 2.0

descriptors 'x3 bt ¥ g
interface,
direct

analysis driver = ‘rosenb:ock'l

responses,
num objective_functions = 1
no_gradients
no_hessians

4 »

[{1) Define Problem b2 Define F.Iowﬂtera.tian. P .| Execute Problem | P ! Visualize Results

- ) strategy (strategy)

i single_method
graphics
» tabular_graphics_data
method (method)
swa Multidim_parameter_study
partitions
model (model)
saa Single

| vanables (variables)

| continuous_design
lower_bounds
upper_bounds
descriptors

) interface (interface)

o  analysis_drivers
iaa direct
responses (responses)
<au Num_objective_functions
a i
saw No_gradients
i4» no_hessians

Figure 52: rosenbrock_2d input file

In Figure 53 notice the following:

cleaner look (extra spaces and newlines removed);

analysis_driver replaced with analysis_drivers (the DAKOTA default

keyword);

direct now a sub-element of analysis_drivers (ordered according to the

DKAOTA input specification syntax); and

double quoted “x2” replaced with single quoted 'x2’ (uniformity).
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2= strategy

3 single method

4 graphics

5 tabular_ graphics_data

&~ method

7 multidim parameter study

8 partitions 8 8

5= model

0 single

variables

continuous_design 2

lower bounds -2 -2
upper bounds 2 2

(o
1 on o n b W N

1 descriptors 'x1' 'x2'
16< interface
1 analysis drivers 'rosenbrock’
18 direct
S~ responses

num objective_functions 1
no_gradients
no_hessians

(SIS TN NI N
AN =

w

Figure 53: “Updated” rosenbrock_2d template input file after using the format option

To execute DAKOTA to perform this two-dimensional parameter study, select the tab “(3)
Execute Problem” at the bottom (see previously in Figure 27). Click “Check”. Notice the
following output (for reference see Figure 30Error! Reference source not found.):

¢ actual DAKOTA command (in green) that just ran, followed by.
e output of DAKOTA’s check mode.

Now go back to the Source (1st tab):

e Find tabular_graphics_data (around line 5), create a new line below and press Ctrl-Space.
Notice a list of potential keywords are listed in a dropdown, see Figure 54.

* Press up or down arrows to navigate.

¢ Navigate to “output_precision” but DO NOT press Enter.

1= strategy
2 graphics
3 single_method
4 tabular_graphics_data
5
[ = T : | |strategy *
A - a
7= meth| = tahular_grap‘h‘lcs_file tabular:graphics.data tabular_graphics_datae (Tabulation of graphics data)
8 1] output_precision tabular_graphics_file (File name for tabular graphics data): Str
9 @ results_output
1e- varil [1] iterator_servers StratCommands.htmI#StratindControl

12 iterator_self_scheduling
iterator_static_scheduling

No subelements

method

. variables
inte 3
interface

LT T

responses
19= resp|

L
22 nc_hessians

Figure 54: Ctrl-Space Auto-completing keywords in the text editor.
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Notice that strategy is highlighted in the text, and also listed next to output_precision.
Auto-completing keywords are reverse sorted, so that keywords at the top are the closest
context-matching keywords. This helps you discover relevant keywords.

Select output_precision by double clicking.

¢ Notice auto-complete types in an equal “="” for you to remind you to enter a value and a
yellow triangle with exclamation appears indicating missing data.

e Type in “notinteger” for the value of output_precision. A red circle with X and red
underline appear to indicate an error. Mouse over it (as in Figure 55) to see the reason
for the error.

5 output precision = notinteger

ERROR: Detected an invalid keyword "notinteger’

11+~ varraores

Figure 55: Text error detailed message.
e Correct by replacing it with a valid integer, such as 9, and notice error marker disappears.
¢ Onthe next line, type in “iterato”, then right after the “0” in “iterato”, press Ctrl-Space.

¢ Notice auto-completion can also finish off half-completed keywords. Pick one (see Figure
56).

B e iterato

7 [ Istrategy *
8 (Ll iterator_servers - strategy il‘er;l‘or_serms (Number of iterator servers): Integer
= method iterator_self_scheduling
converg ( iterator_static_scheduling StratCommands.htmlZStratindControl
optpp_g
12= variables No subelements
13 cont im.a |
14 ind)|

lowi|
uppli|
des| |

18- interface |
19 analysi
20 Syfﬁl
21= responses |
calibral
analytic gradients

Figure 56: Text editor auto-completion of partial words.

Save this edited rosenbrock file as your own template (see Figure 49): File = Save As
Template

¢ Notice: the default save location is that specified earlier in the Jaguar Preferences.
¢ Name it “Rosenbrock Fixed”.
¢ Click “Save”.

Close all files (Ctrl-Shift-W) or File - ”Close All”. No need to save changes.
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Click on File - New -> DAKOTA input file from template. Notice that both JAGUAR and
User-created templates are available.

¢ Do either of the following:
1. Type “Fixed” in the quick search bar and select “Rosenbrock Fixed”.

2. Navigate down and select “Rosenbrock Fixed”.

r - i &
5% DAKOTA Templates - - L.._'LM

DAKOTA input file templates
Choose a template for the basis of the DAKOTA input file:

Pick a template:
type filter text
4 DAKOTA templates -
dudd3
dude
L dude2
rosenbrock

m

rosenbrockwhatever
Rosenbrock Fixed
sample template
testagain
4 '] Jaguar standard templates
M Calibration Local Datafile Example
)| Preview template content:
J| =% DAKOTAINPUT FILE - dakota_rosenbrock_2d.in -
strategy
single_method
graphics
tabular_graphics_data
method
multidim_parameter_study
partitions 88
model
single
I variables
continuous_design 2
lower_bounds -2 -2

[T

"7?> Bac Next > Finish Cancel

Figure 57: Rosenbrock Fixed DAKOTA Template.

¢ Notice in Figure 57 that:

1. This time we are creating an input file from a user-created template.

2. User-created templates do not have stars on them and are listed at the top.
e A preview of the template file should be visible.
e Select “Next”.
e Specify a filename such as “rosenbrock_fixed.i”.
e Select “Finish”.

This completes the basic tutorial showing a few features of JAGUAR.
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12: Troubleshooting

In case of unresolvable errors, review the current JAGUAR FAQ linked from the download page
and the DAKOTA web pages. The most common troubleshooting options are excerpted here for
convenience:

1. Check for sufficient Java version: In a terminal or Command Prompt type “java -version”.
You should have at least Java 1.6.

2. If there exists a corrupted JAGUAR workspace, remove the workspace (User_folder >
Jaguar_workspace) and configuration (User_folder > .jaguar-configuration).

3. If some window views are missing or if they are incorrectly positioned, restore the
default view by selecting: Window—>Reset Window Layout

4. Enable Error Log: Window—>Show View—>Error Log (see Figure 58). This view will
provide detailed logging of anything that went wrong inside JAGUAR.

File Edit | Window | Help
[.F‘i *Rosen New Window
Defi Mew Editor
1
gine Show Toolbar
Section  ghow View » B Console Alt=Shift+ Q, € L
type fi <) 2 +
pefi Reset Window Layout @) Emorlog Alt+Shift+Q, L 3
<3 8% Outline AltsShift+Q, O
Preferences [ Problems Alt+Shift+Q, X
@ VIR |
Variables (variables Cther... Alt+5Shift+Q, Q
e

Figure 58: Enabling JAGUAR Error Log.

Send any errors listed to our support email jaguar-help@sandia.gov.
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1 MS0899 Technical Library 9536 (electronic copy)
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